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ARCHICAD voor ontwerpers en tekenaars

Doel  
Het doel van deze kennismodule is vertrouwd te raken met geavanceerde functies binnen ARCHICAD. Evenals het uitwerken van complexe, 
specifieke gebouwdelen zoals vliesgevels, gekromde daken en dakkapellen.  

H-01: 3D Modelleren  
Het project modelleren in 3D met de 3D bewerkingsmethoden.  

H-02: Vliesgevel  
Hoe te werken met het vliesgevel gereedschap. Toepassingsmethodes en hoekoplossingen voor de vliesgevel. Het aanmaken van eigen 
profielen en panelen.  

H-03: Daken, Multi-plane roof  
Het uitwerken van complexe dakstructuren. Ronde of scheluwe daken tekenen. Een dakkapel toevoegen met de juiste aansluitingen. 
Platte daken en algemene aansluitingen.  

H-04: Shell Tool  
Gekromde daken teken met het shell gereedschap.  

H-05 Dakkapellen  
Een stappenplan voor het tekenen van dakkapellen. 

H-06: Roof Maker  
Met deze ingebouwde add-on kan een dak met enkele klikken voorzien worden van een dakstructuur.  

Modelleren + 

Cursusinhoud  
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01  3D Modelleren

Editing Plane = Rastervlak in het 3D venster dat referentie geeft tijdens het modelleren in 3D 
 
Eigenschappen 
• Groter dan de getekende elementen. 

Tip: 
Er kan ook op de raster-snijpunten gesnapt worden: 

• Zet in het menu View de ‘Grid Snap’ aan. 
• Kies bij het menu View > Grid Snap Options: ’Construction Grid’. 

• De positie kan handmatig aangepast worden 
In het Editing Plane staat een blauw vierkantje: Editing Plane Grip. 
Door op het vierkantje te klikken verschijnt een menu om het rastervlak te verplaatsen en projectie aan te passen. 
De mogelijkheden zijn afhankelijk van het type gereedschap. 

Met de functie ‘Pick Plane’ kunnen tijdens het tekenen andere vlakken in het model aangewezen worden als Editing Plane.  
Nieuw te tekenen elementen kunnen dan (indien mogelijk) evenwijdig aan de Editing Plane getekend worden. 

 
Aan- en uitzetten 
Onder het menu  View > Editing Plane Display kan het Editing Plane aan of uit gezet worden worden.

Tekenhulp in het 3D venster 

3D Editing Plane
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Eigenschappen 
• Oranje stippellijn waaraan gerefereerd kan worden 
• Blijven altijd staan 
• Worden niet afgedrukt 

Hulplijnen oproepen 
• Zorg ervoor dat de Guide Lines AAN staan: 

• knop in knoppenbalk, menu View of sneltoets: ‘L’ 
• ‘Sleep’ uit een van de ‘Guideline Tabs’ aan de zijkanten van het tekenvenster een hulplijn 
• Plaats de lijn: 

• Willekeurig: klik ergens  
• Refererend aan een bestaand element in elke willekeurig richting: laat los op het element 

Verplaatsen 
• Ga op een Guide Line staan: de ‘Guide Line Handle’ verschijnt 
• Sleep naar de gewenste plaats 

Verbergen 
• Zet de Guide Lines UIT 

• knop in knoppenbalk, menu View of sneltoets: ‘L’ 

Verwijderen  
• Ga op een Guide Line staan en roep het rechtermuisknop menu op 
• Kies om alle Guide Lines, alleen de geselecteerde lijn of zelf aan te wijzen (Erase) lijnen te verwijderen

Permanente hulplijnen 

Guide Lines

02- �5

Ruimte voor aantekeningen 
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02 Vliesgevel

Een vliesgevel wordt met alle onderdelen in één keer getekend op basis van de  
instellingen in het gereedschap. 
Uiteraard kan de vliesgevel later nog altijd aangepast worden.  
 
 
 

 
 
Wijzigen 
Voor het wijzigen van een vliesgevel is er een 3D bewerkingsmodus met specifieke  
gereedschappen waarin de verschillende onderdelen van een vliesgevel individueel  
aangepast kunnen worden. 

Vliesgevel 

Curtain Wall Tool 
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De losse onderdelen van de vliesgevel worden volgens een aanpasbaar patroon (Scheme) geplaatst. 

Frame 
• Boundary = omtrek 
• Mullion = stijlen of regels van de hoofdrichting 
• Transom = stijlen of regels tussen de mullions 

Panelen 
• Main = Primaire panelen 
• Distinct = Secundaire panelen 

Knopen 
• Worden geplaatst op de snijpunten van het patroon.  

Gaat het om enkele knopen dan worden ze achteraf geplaatst. 

Accessoires 
• Accessoires (bijv. zonwering) worden na het plaatsen aan de vliesgevel toegevoegd,  

maar zijn wel onderdeel van de vliesgevel.

Vliesgevel onderdelen 

Curtain Wall Members  
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Opzet 
Het instellingsvenster voor vliesgevels bevat 2 gedeelten. Aan de linkerkant kunnen  
alle onderdelen van een vliesgevel geselecteerd worden.  
Aan de rechterkant kan het gekozen onderdeel ingesteld worden.  
De menu’s aan de rechterkant verschillen per systeemonderdeel. 

In de eerste gedeelten, Curtain Wall System en Scheme, worden de basisinstellingen  
voor het systeem opgezet. Deze instellingen gelden later voor de hele vliesgevel. 

Aanpak 
De meest efficiënte methode om een vliesgevel op te zetten is eerst een systeem  
en patroon te kiezen en juist in te stellen en ná het plaatsen de individuele  
aanpassingen te maken. 

Vliesgevel instellingen 

Curtain Wall Default Settings - ARCHICAD 22 instellingen 
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Geometry and Positioning 
• Home Story (1) 
• Nominale dikte = maat tussen de referentielijn en de buitenkant van de vliesgevel.  

(wordt gebruikt bij het verbinden van wanden of zones) 

Member Placement  
• Knooppunten - gebruik bij een onzichtbaar frame 'At all Grid Points’. 
• Positie van de randprofielen t.o.v. de buitenrand.  

De overige onderdelen werken zoals bij de andere gereedschappen.

Vliesgevel instellingen 

Default Settings - Curtain Wall System
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2

Het patroon bepaalt de structuur van de vliesgevel. Dit schema of grid wordt getekend op de  
positie van de glaslijn en is voor het opzetten van een vliesgevel bedoeld; het blijft op de  
tekeningen onzichtbaar. 

Grid Pattern 
In de Default Settings worden de afmetingen van de kolommen en rijen bepaald.  
Langs de grenzen van deze vlakken worden de stijlen en regels van  
de vliesgevel geplaatst. Met de + en – knoppen (1) kunnen vlakken toegevoegd of verwijderd  
worden. De rijen kunnen tevens onder een hoek gezet worden (2). 

Panels 
In het previewvenster worden zowel de proporties van de instellingen weergegeven als de  
typen panelen. Door een paneel te selecteren het type paneel aangepast worden (3) 

Pattern Origin 
Hiermee wordt aangegeven hoe het patroon en daarmee de stijlen ten opzichte van de  
referentielijn komen te staan. 
• Beginpunt is zowel horizontaal als verticaal op verschillende punten te beginnen. 
• Mogelijkheid om numeriek aan te geven waar het patroon begint ten opzicht van het beginpunt.

Vliesgevel instellingen 

Default Settings - Scheme  
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In de frame instellingen worden type en afmetingen van de profielen ingesteld. 
Omtrek, stijlen en regels worden elk apart ingesteld, de instellingsvensters zijn echter gelijk. 

Gelijke Profielen 
In geval alle profielen gelijk moeten zijn, dan kan dit met behulp van een favoriet  
overgebracht worden.  

Let op! 
De profielen worden niet gekoppeld en kunnen dus ieder apart weer gewijzigd  
worden. 

Profieltype 
Kies bij de instellingen (1)  het type profiel. Afhankelijk van de keuze verandert  
het parameter- en het previewvenster. 

In het parametervenster worden links de profielhoogte (b), profielbreedte (a) en de positie  
van de glaslijn (h) aangegeven. Daaronder worden de sponningdiepte (d) en sponningbreedte (w)  
bepaald. 

De Frame Intersection Priority geeft een prioriteit aan de verschillende stijlen. Deze prioriteit zorgt ervoor dat stijlen met een hogere 
prioriteit doorlopen. Na het plaatsen is deze prioriteit (per stijl) aan te passen.

Vliesgevel instellingen  

Default Settings - Frame
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Invisible 
Het frame is aanwezig maar niet zichtbaar.  
De voegen tussen de panelen zijn zichtbaar. 

Built-in Frame 
Het meest gebruikte frametype. 
De afdeklijsten/kliklijsten/klemprofielen van de stijlen en dorpels zijn zichtbaar aan de  
binnen- en buitenkant. 

Volglas 
De panelen sluiten aan de buitenkant van de dorpels en stijlen aan. 
Het frame is alleen van binnen zichtbaar. 

Vliesgevel soorten 

Default Settings - Frametypes (1)
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Profiel basis 
In eerste instantie gelijk aan ‘Built-in Frame’. 
Uitgebreider instelbaar met parameters. 

Profiel modulair / Profiel geprofileerd 
Gedetailleerd frame met meer parameters. 
Er kan gebruik gemaakt worden van eigen profielen voor frame, stijlen,  
dorpels en afdeklijsten. 

Vliesgevel soorten 

Default Settings - Frametypes (2)
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Basispanelen 
In de basisinstellingen kan van twee verschillende typen panelen gebruik gemaakt worden: 

• Primaire panelen (Main Panel), welke standaard ingesteld zijn als glas met 20 mm dikte. 
• Secundaire panelen (Distinct Panel), standaard dichte panelen van 20 mm dikte. 

Aanvullende paneelklassen 
Via de knop ‘Add’ is het mogelijk om aanvullende panelen aan te maken.  
De hier gekozen panelen kunnen op alle panelen van de vliesgevel toegepast worden zoals  
deze in de Scheme Settings ingesteld zijn. 

Overige panelen 
Ramen, deuren, andere materialen en dergelijke kunnen als paneelklasse aangemaakt  
worden of later in de 3D bewerking geplaatst worden.

Vliesgevel paneel 

Default Settings - Panels
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Junctions 
Vliesgevels zonder stijlen en regels (invisible) maken gebruik van junctions,  
verbindingselementen voor de beglazing. 
Als bij de systeeminstellingen Member Placement > At all Gridpoints aangegeven is,  
worden de verbindingen bij het tekenen meteen geplaatst. Is hier voor One by one gekozen  
dan moeten de verbindingen achteraf handmatig geplaatst worden. 
De verbindingen worden ingesteld via de parameters van het object. 

Accessories 
Accessories zoals bijvoorbeeld zonweringen worden niet automatisch geplaatst.  
Deze kunnen later aan de vliesgevel toegevoegd worden.

Vliesgevel accessoires  

Default Settings - Junctions en Accessories
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Vliesgevels kunnen op de plattegrond, in het 3D venster, in gevelaanzichten en in doorsneden geplaatst worden. Sommige tekenmethoden 
zijn echter alleen in 3D beschikbaar. 

Rechte en polygoon gevels 
Met methode 1 wordt een rechte vliesgevel getekend, als optie kan ook een polygoon getekend worden.  
Deze methode biedt met behulp van een petpalet de mogelijkheid rechte en gekromde vliesgevelsegmenten aan elkaar te tekenen. 

Gekromde gevels 
Gekromde vliesgevels kunnen met methode 2 getekend worden. Zoals bij het cirkelgereedschap kan er gekozen worden tussen tekenen 
vanuit het middenpunt, met 3 punten of twee raaklijnen. De laatste optie in het submenu is geschikt voor het tekenen van gekromde 
glasdaken. 

Aanzichten 
Methode 3 is voor het tekenen van vliesgevelpolygonen (aanzichten) in plattegronden (horizontaal), gevelaanzichten (verticaal) en 3D. 

Vliesgevel tekenen 

Geometriemethoden
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• Stel de instellingen juist in. De hoogte en helling kunnen hierin ingesteld worden. 

• Teken de referentielijn. 

• Geef met Flip (sneltoets F) de juiste oriëntatie aan.

Vliesgevel tekenen 

Tekenen op plattegrond
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Aanzichten 
Vliesgevels kunnen ook in gevel- en doorsnedevensters getekend worden, bijvoorbeeld als het gebouwmodel al is opgezet en alleen de 
vliesgevel ontbreekt. 
Ook hier is het makkelijker eerst de systeeminstellingen goed in te stellen voordat de vliesgevel getekend wordt. 

• Kies voor het tekenen met de omtrekmethode. 

• De vliesgevel wordt hierbij op de plaats van de aanzichts- of doorsnedelijn getekend. 

Tip:  
Deze geometrie kan ook op plattegronden gebruikt worden voor glasdaken. 

3D 
Er zijn verschillende methoden om in 3D een vliesgevel te tekenen. 
Deze werken op verschillende manieren, afhankelijk van welke geometriemethode gekozen is. 

Er kunnen bijvoorbeeld met behulp van hoogtepunten in twee richtingen hellende daken in 3D getekend worden. 

Vliesgevel tekenen 

Tekenen in gevels en doorsneden
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Een aantal wijzigen kunnen direct worden uitgevoerd in de standaardvensters en instellingsvensters : 

Referentielijn oprekken 
Een vliesgevel kan op de plattegrond gewijzigd worden zoals een wand. 
Klik op de referentielijn om de vorm van de vliesgevel te wijzigen door het petpalet te gebruiken. 

Hoogte 
• Na plaatsing kan de (plaatsings-)hoogte gewijzigd worden bij de Curtain Wall Selection Settings. 

• Ook in het 3D venster kan de hoogte grafisch veranderd worden. 

Voor de meeste aanpassingen wordt echter gebruik gemaakt van het speciale Edit Modus voor de  
vliesgevels.

Vliesgevel 

Wijzigen van vliesgevels
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Na het selecteren op de plattegrond verschijnt in het midden een knopje Edit in 3D voor de 3D bewerkingsmodus. Na het selecteren in 3D 
verschijnt de knop Edit. 

In deze modus zijn alleen de vliesgevel-gereedschappen beschikbaar,  
waarmee de losse onderdelen van de vliesgevel apart geselecteerd en  
aangepast kunnen worden. 

Toolbox 
De Toolbox bevat naast de selectie methoden de verschillende onderdelen  
van de vliesgevel. Dit werkt zoals gebruikelijk in ARCHICAD. 

Curtain Wall Scheme Tool 

Curtain Wall Frames Tool 

Curtain Wall Panel Tool 

Curtain Wall Junction Tool 

Curtain Wall Accessory Tool 

Environment: Hiermee kan het model (de context) aan of uitgezet worden. 

Na op OK te klikken worden de aangebrachte wijzigingen overgenomen en de bewerkingsmodus afgesloten.

Vliesgevel 

Wijzigen in 3D Edit Modus
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Selecteren 
Voor het selecteren van dezelfde onderdelen die naast / boven elkaar liggen verschijnen bij het selecteren nieuwe icoontjes naast het object.  
Bij het klikken hierop kunnen alle losse onderdelen uit de pre-selectie in één keer geselecteerd worden. 

Bewerken grid 
Voor het bewerken van het grid (Scheme) in 3D is er een apart petpalet. 
Er kunnen vier bewerkingen verschijnen in het petpalet. Dit is afhankelijk van de selectie,  
het hele grid of een enkele gridlijn: 

1. Gridlijnen (stijlen) van het schema verplaatsen. 
2. Het hele grid ten opzichte van de omtreklijn verplaatsen. 
3. Verticale of horizontale gridlijnen roteren. 
4. Het hele grid roteren. 

Let op! 
Het petpalet verschijnt alleen bij het klikken op de randen en punten van het grid en  
niet op de randen van de omtreklijn!

Vliesgevel 

3D Edit Modus - Selecteren en bewerken (1)
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Grid 
      Omtrek

1  2  3  4

Omtrek gevel 
Het polygoon van de omtreklijn  kan aangepast worden op dezelfde wijze als een gewone polyline bewerkt  
wordt. Het petpalet biedt de mogelijkheden punten toe te voegen, afronden, afronden met raaklijn  
en rand oprekken. 
In de 3D bewerkings modus kan een gevel ook opgerekt worden. Dit wordt door het verlengen van de  
referentielijn gedaan. 

Ronde basislijn 
Om vliesgevels achteraf een ronding te geven kan de referentielijn met behulp van de functies in  
het petpalet gekromd worden. 

Let op! 
Vliesgevels kunnen alleen uit rechte delen opgezet worden. De gevel blijft dus altijd een  
polygoon, en wordt geen dubbelgekromd vlak.

Vliesgevel 

3D Edit Modus - Selecteren en bewerken (2)
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Schema 
       Omtrek

Referentielijn
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03 Daken, Multi-plane Roof

Single-plane Roof 

Single-plane Roof - Settings  
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Gebruik 
• Enkele dakvlakken 
• Platte daken 

Eigenschappen 
• Positie in het project - Homestory 
Een dakvlak wordt met een spil-as (Pivot line) op hoogte gelegd (1). Deze ligt aan de onderzijde 
van het dakpakket. Kies een hellingshoek (2) en een afschuining van de randen (3). 

• Structuur en opbouw 
Voor daken kan er voor verschillende soorten opbouw (4) gekozen worden: 
• Basis - enkel materiaal met zelf te bepalen dikte (5) 
• Composite - meerlaagse opbouw: dikte (grijs) wordt bepaald door de composiet. 

Let op! 
Teken het dak op de juiste verdieping!! 
Daar waar het dak zichtbaar moet zijn op de plattegrond. 

• Geometriemethoden (5)         
enkel dakvlak (Single-plane) 
meerzijdig dak (multi plane) 

• Constructiemethoden       
• Bij enkel dakvlak: Polygoon, Rechthoek, Rechthoek onder een hoek  

4
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Een enkel dakvlak tekenen  

1. Teken eerst de Pivot line = spilas 
De lijn waarop alle punten op een bepaalde hoogte liggen. 
Dit is meestal op de hoogte van de muurplaat, maar kan ook de nok of een andere niveau zijn. 
 

2. Geef met de oogcursor aan, aan welke kant van de Pivot line het dak omhoog gaat. 
 
 

3. Teken de vorm van het dakvlak zoals het er op de plattegrond uitziet. 
Teken eventueel het dakvlak eerst precies over de wanden heen en geef daarna het totale dakvlak een 
offset voor de overstek. 

Daken - Enkel dakvlak plaatsen 

Roof-gereedschap - Single-plane

1

2

3

Single-plane Roof 

Nok opzoeken van 2 Single-plane Roofs 
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Snijlijn opzoeken van twee dakvlakken 
1. Teken beide dakvlakken 
Het is belangrijk dat de pivotline op de juiste positie ligt en alle zijden van het dak aanwezig zijn. 

2. Snijlijn (nok) opzoeken van twee dakvlakken 
Dit kan zowel in het 2D venster als het 3D venster, het 3D venster geeft het meeste overzicht. 

• Selecteer het referentie-dakvlak (Shift-klik) 
•        Ctrl-klik /      Cmd-klik op de dakrand (mercedes teken) die hiernaar verlengd moet worden 

Doe dit vervolgens ook andersom: 
• Selecteer het andere dakvlak als referentievlak (Shift-klik) 
•        Ctrl-klik /      Cmd-klik op de dakrand (mercedes teken) van het eerste vlak 

Ctrl+klik / Cmd+klik

Ctrl+klik / Cmd+klik



Dakhelling aanpassen in 3D of in doorsnede. 
Petpalet oproepen op een hoekpunt van de nok. 
Refereren aan verdiepingen is mogelijk.  
 

Single-plane Roof 

Nok bepalen, dakhelling wijzigen
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Bepaal de helling aan de hand van de goothoogte en nokhoogte.  
• Kies de gewenste spil-as hoogte en een willekeurige helling. 
• Teken de spil-as op de juiste plaats. 
• Selecteer het dakvlak.  
• Ctrl-klik / Cmd-klik op een hoekpunt van de NOK om de Roof Elevations op te roepen. 
• Vul de gewenste nokhoogte in (Top = buitenzijde , Bottom = Binnenzijde). 
• ARCHICAD berekent de helling en wijzigt het dakvlak.  

Single-plane Roof 

Goothoogte - nokhoogte 
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Single-plane Roof 

Plat dak  
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•  0° 
• Niet zichtbaar op situatie/ inplantingplan* 
• Composites Slab 
• Reference plane aanpasbaar 
• Geen Pivotline (spil-as) 
• Building Materials Priority functioneert automatisch 
• Automatisch afgeknipt via BMP 
• IFC parameter nog aan te passen naar ‘Dak’ 

Dakramen 
• Opening handmatig maken  
• Dakramen niet gekoppeld aan de helling 

•  0° - 89° 
• Wel zichtbaar op situatie/inplantingplan* 
• Composites Roof 
• Geen reference line 
• Pivot line (spil-as) aan de onderkant  
• Building Materials Priority werkt enkel na extra handeling 

(Connect > Merge elements of Trim Elements to Roof/Shell) 
• IFC parameter correct 

Dakramen 
• Opening automatisch  
• Dakramen gekoppeld aan de helling 

*Situatie/Inplantingsplan = weergave van de begane grond/het 
gelijkvloers met omgeving met een aangepaste kijkhoogte 
(FPCP)

SLAB Tool                                 ——————                                 ROOF Tool

Stap 1: Composiet maken voor een groendak 
• Maak een composiet met de gewenste Building Materials aan.  

Voeg slabben als schil hieraan toe. 
• Stel de beschikbaarheid in voor Slabs en Roofs 

Single-plane Roof 

Groendak (Single-plane Roof)  
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Stap 2: Randdetaillering 
Het randdetail kan getekend worden met een Complex Profile.  
Hierdoor wordt het in 3D en doorsnede correct weergegeven.

Single-plane Roof 

Groendak (Single-plane Roof)  
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Single-plane Roof 

Groendak (Single-plane Roof)  
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WALL TOOL 
Complex Profile

Roof - Wall (composite) 
• Connect > Merge elements 
• SEO > Substract

OBJECT TOOL 
Gravity to Roof

Wall (Complex Profile) - Roof 
• SEO > Substract with upward extrusion

Wall (Complex Profile) - Wall (composite) 
• SEO > Substract

ROOF TOOL 
Single-plane
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Stap 3: Aansluitingen en aankleding 
Maak de aansluiting correct: 
• Door Complex Profiles met Solid Element Operators uit het dak en wand te knippen  
• Door bij de dakaansluiting met de wand Connect te gebruiken  

WALL TOOL 
Composiet

WALL TOOL 
Composiet



05- 
Daken - Meervlaksdak plaatsen 

Roof-gereedschap – multi-plane 

Constructiemethoden 
Polygoon, Rechthoek schilddak/zadeldak,  
Rechthoek onder een hoek schilddak/zadeldak 

Aanvullende instellingen dak (tabblad Multi-plane Geometry) 
• Meerdere hellingen / vlakken (1) 

Met de knop ‘Add’ kan het dak uit vlakken met verschillende hellingen, materialen en/of 
aanvangshoogte worden opgebouwd. 

• Dakhelling = Pitch (2) 
Voor Level 1 gekoppeld met waarde in Geometry and Positioning  

• Hoogte dakhelling (3)  
alleen bij meerdere niveaus: hoogtebereik waarvoor de dakhelling geldt  

• Overstek (4)  
deze kan direct getekend worden 

• Segmentering (5)  
voor gebogen dakvlakken

�34

1 2 3

4 5
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Algemene instellingen worden gewijzigd in de Roof Tool Settings 
Voor het wijzigen van de vorm wordt het petpalet gebruikt. 
Let goed op de plaats waar het petpalet wordt opgeroepen 

05- 
Daken - Meervlaksdak aanpassen 

Multi-plane Roof - onderdelen  
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C nok wijzigen B instellingen dakrand

A instellingen dakvlak en dakvorm (Custom Plane Settings)

level 1

level 2

Pivot line

level line



Petpalet oproepen met een klik op de pivot lijn van het meervlaksdak. 

Doel:  
• De helling aanpassen of geheel verwijderen. 
• Surface override bovenkant en onderkant. 
• De segmentering aanpassen bij een gebogen pivot lijn. 

Toe te passen op: 
• Het aangeklikte dakvlak. 
• De dakvlakken op 1 verdieping. 
• Alle dakvlakken van het meervlaksdak.

Multi-plane Roof 

Instellingen dakvlak  
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Petpalet oproepen met een klik op de rand van het meervlaksdak. 

Doel:  
De afsnijding van de dakrand aanpassen. 
Surface override zijkanten. 
Definitie type dakrand. 

Toe te passen op: 
De aangeklikte dakrand. 
De dakranden van het polygoon. 
Alle dakranden van het meervlaksdak. 

Petpalet oproepen met een klik op de rand van een Single-plane roof.

Multi-plane Roof 

Instellingen dakrand

M+ - �37

B



Nok wijzigen 3D 
• Ga naar het 3D venster 

• Roep op de noklijn of hoekpunt van nok het pet palet op 

• Kies ‘Elevate horizontal Ridge’ 

• Verplaats de nok grafisch door te refereren 
naar andere punten of numeriek invoeren. 

05- 
Daken - Aanpassen nokhoogte 

Roofgereedschap - Multi-plane 
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05- 
Daken toepassingen 

Dak met wolfseind 

Een Multi-plane Roof met 4 dakvlakken aanpassen naar een dak met Wolfseind 
• Selecteer het dak en stel een extra level in (1) (de pitch is gelijk van beide levels)  

De ‘elevation’ van level 1 bepaalt de hoogte waar het wolfseind begint (2) 
• Roep op de Pivot line het petpalet op en kies ‘Custom Plane Settings’ 
 

• Verander hier ‘Plane Type’ naar ‘Gable’ met een helling van 90 (3)

�39
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Level 1

Level 2

Pivot line

Dakrand

3



Maak gebruik van de Magic Wand (Toverstafje) om de vorm van een Multi-plane roof te bepalen. 
1. Teken de vorm met een polyline of fill gereedschap. 
2. Kies voor Multi-plane Roof en de geometriemethode : complex roof. 
3. Stel het gereedschap naar wens in. 
4. Druk de spatiebalk in om het toverstafje op te roepen. 
5. klik op de rand van de reeds getekende figuur.  

Daken toepassingen 

Vorm overnemen
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05- 
Multi-plane Roof - Meervlaksdak omzetten naar enkelvlaksdaken 

Split into Single-plane Roofs  

Soms gaan bewerkingen makkelijker met single-plane daken.  
De meervlaksdaken kunnen dan omgezet worden naar single-plane dakvlakken. 

Stappen 
1. Selecteer het dak (Multi-plane Roof) 

2. Kies Edit > Reshape > Split into Single-plane Roofs 
of rechtsklik op het dak > ‘Split into Single-plane Roofs’ 

3. Melding: Het originele Multi-plane roof wordt verwijderd ,  
evenals de reeds geplaatste afmetingen! - Kies ‘Split Anyway’ 

Let op! 
Ook de maatvoering van het meervlaksdak wordt verwijderd.
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Single-plane Roof - Multi-plane Roof 

Afknippen aan het dak 

M+ - �42

Solid Element Operation Trim to Roof Crop to roof (zone)

Design > Solid Element Operations… Design > Connect > Trim Elements to Roof/Shell Design > Roof Extras > Crop to Single-plane Roof…

• Werkt alleen met Single-plane Roofs. 
• Undo via het menu Design > Roof Extras > 

undo all crops 
• Wijzigt niet mee met het model. 
• Geen verbindingen volgens BMP

• Alleen toegepast volgens trimming body roof. 
Geeft problemen als elementen buiten de 
Trimming Body vallen. 

• Daken / Shells mogen niet verwijderd  
worden. 

• Veel handelingen 
• Openingen in het dak worden niet  

meegenomen. 
• ‘Operators’ mogen niet verwijderd  

worden. 
• Geen verbindingen volgens BMP

• Daken kunnen verwijderd worden. 
• Mogelijkheid om de maximale afmetingen van 

afgeknipte elementen te wijzigen.  
• Keuze om de elementen in het  

dak te negeren. 
• Openingen in het dak worden als dak gezien 

en knippen elementen ook af.

• Snel, weinig handelingen. 
• Volgt het live model bij wijzigingen. 
• Openingen in het dak worden als dak gezien  

en knippen af tot de bovenzijde van het dak. 
• Keuze om de boven of onderkant te behouden. 
• Verbindingen volgens de Building  

Material Priorities (BMP).

• Vele verschillende mogelijkheden om af  
te knippen.  

• Mogelijkheid tot overname van de  
surface van één van de elementen. 

• Volgt het live model bij wijzigingen.

Voordelen

Nadelen

Alles wat zich binnen het trimming body van een dak bevindt wordt  
bewerkt met de functie Trim to Roof. 

Zichtbaar maken in 3D. 
Ga naar View > On-Screen View Options > Trimming Bodies

Single-plane Roof - Multi-plane Roof - Shells 

Trimming Bodies  
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Trimming bodies zijn op 2 manieren te bepalen bij een dak getekend met  
het dak gereedschap.  
• Contours down (Het Trimming body volgt de contourlijn van het dak.)  
• Pivot lines down (Het Trimming body volgt de pivot lijn van het dak.) 

Open het instellingenvenster van het betreffende dak om het Trimming Body van 
het dak aan te passen.  

Single-plane Roof - Multi-plane Roof 

Trimming Bodies 
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Selecteer het dak(vlak) om een hoogtelijn onder een hellend dak 
te bepalen. Ga naar : 
Design > Roof Extra’s > Create Roof Level Lines… 

Stel de juiste hoogte in vanaf de verdieping/het project nulpunt  
tot de onder-/bovenkant van de dakstructuur  

Omit Lines Outside Roofs = 
Hoogtelijnen weglaten die niet binnen de grondplan-polygoon  
van het dak vallen. (Als dit is uitgevinkt worden hoogtelijnen  
even lang als de pivotlijn van het dak getekend.) 

Group with Roof = De hoogtelijnen met het dak groeperen.

Single-plane Roof - Multi-plane Roof 

Roof Level Lines  
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Modelleren +

04 Shell Tool

De Shell Tool is een gereedschap waarmee op verschillende manieren vrije vormen gemodelleerd kunnen 
worden. Dat kunnen zowel geëxtrudeerde vormen, draaibankelementen als dubbelgekrommde vlakken zijn.  

Na het opzetten van een basisvorm kunnen buitencontouren aangepast worden. Er kunnen openingen 
gemaakt en daklichten geplaatst worden.  

Modelleervrijheid met vrije vormen  

Shell tool  
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Er zijn verschillende typen shells beschikbaar die ook gecombineerd ingezet kunnen worden. 
 
Na het activeren van het shell gereedschap zijn in de infobox en in het instellingenvenster drie 
tekenmethoden mogelijk:  

                    Extruded Shell                            Revolved Shell                                 Ruled Shell  
                    geëxtrudeerd                              draaibank element                          dubbelgekromde vorm  

Basisvormen  

Shell typen 
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Shells bestaan uit verschillende onderdelen die (grotendeels) vervormd kunnen worden:  

1. Het nulpunt (hotspot met groene rand) is het eerste punt dat bij het tekenen geplaatst wordt. De hoogte kan in infobox en in 
het instellingenvenster numeriek worden ingevoerd.  

2. De ‘Profile vector’ (blauw) is een lijnpolygoon die naar wens vervormd kan worden en de vorm van de shell bepaalt. Er 
kunnen punten aan toegevoegd worden, randen afgerond worden enzovoort.  

3. De ‘Extrusion vector’ (blauw) is een soort referentielijn die de richting van de te extruderen vorm bepaalt. Bij ‘Revolved 
Shells’ is het de rotatieas van het draaibank element.  

4. Sommige randen zijn statische randen die niet kunnen worden vervormd. Er kunnen wel eigenschappen aan deze randen 
toegekend worden.  

Eigenschappen  

Basiscomponenten
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1. Kies een geometriemethode         
Extruded - Revolved - Ruled 

2. Bepaal de hoogte 
3. Kies de opbouw van de shell

Instellingen Shell Tool  

Settings
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Wijzigt per geometriemethode

De shell bestaat steeds uit een profiel dat geëxtrudeerd wordt over de lengte  
van een as (extrusie-as). 
De hoeken kunnen ingesteld worden onder het hoofdstuk Extrusion Properties.  
Het is ook mogelijk om deze achteraf nog aan te passen of te corrigeren door op  
de juiste plaats het petpalet op te roepen.   

Voor α en γ op de bovenkant van de afgeronde rand 

Voor β op de profiel-as 

Instellingen Shell Tool  

Geometriemethode : EXTRUDED
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Tekenmethode : Parallel aan het vlak (eenvoudige boog). 
Makkelijk om mee te beginnen en achteraf te wijzigen. 

 

Teken de shell op het grondplan of in het 3D venster, bewerk de shell daarna in grondplan, doorsnede of 3D. 
1. Klik om het beginpunt aan te geven. 
2. Bevestig de extrusie lengte van de boog (dit is de extrusie-as). 
3. Bepaal de breedte van het profiel.

Instellingen Shell Tool  

Geometriemethode : EXTRUDED
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profiel

extrusie-as

profiel

extrusie-as

Tekenmethode : loodrecht op het vlak (gedetailleerd profiel tekenen)  
Direct het profiel juist tekenen. Daarna extruderen. 

Tip: 
Teken eerst een wand en teken dan het profiel in 3D, zo kan het profiel in de juiste richting extruderen. 

Teken het profiel op het grondplan of in het 3D venster, bewerk de shell daarna in grondplan, doorsnede of 3D. 
1. Teken het profiel via de polygoonmethode. 
2. Dubbelklik om het einde te bevestigen. 
3. Geef de extrusie lengte numeriek in. 

Instellingen Shell Tool  

Geometriemethode : EXTRUDED
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Bij de geometriemethode revolved wordt een profiel rond een rotatie-as gedraaid.  
In de instellingen kan een hoek van de as bepaald worden.  
 
Deze kan ook achteraf worden aangepast door op de rotatie-as te klikken en het 
petpalet op te roepen.  
Ook het profiel kan achteraf nog worden aangepast via het petpalet. 

Instellingen Shell Tool  

Geometriemethode : REVOLVED (gedraaid)
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Tekenmethode : Parallel aan het vlak (eenvoudige koepel). 
Makkelijk om mee te beginnen en achteraf te wijzigen. 

 

Teken de shell op het grondplan of in het 3D venster, bewerk de shell daarna in grondplan, doorsnede of 3D. 
1. Bepaal de diameter van de koepel. 
2. Teken de koepel. 
3. Bewerk de koepel door het petpalet op te roepen bij de profiel-as.

Instellingen Shell Tool  

Geometriemethode : REVOLVED (gedraaid)
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1 2 3

rotatie-as



profiel

rotatie-as

1

2

3

4

Tekenmethode : Loodrecht op het vlak (gedetailleerd profiel tekenen). 
Direct het profiel juist tekenen. Hierna de rotatie-as tekenen en de rotatie bepalen. 

Tip:  
Teken eerst een wand en teken dan het profiel in 3D op die wand, zo kan het profiel in de juiste richting roteren.  
Verwijder achteraf eventueel de wand 

Teken de shell op het grondplan of in het 3D venster, bewerk de shell daarna in grondplan, doorsnede of 3D. 
1. Teken het profiel, dubbelklik om het tekenen te beëindigen.  
2. Kies het rotatiepunt. (Dit kan ook naast het profiel liggen) 
3. Roteer het profiel rond de as getekend vanuit het rotatiepunt.  
4. Bepaal de rotatiehoek numeriek. 

Instellingen Shell Tool  

Geometriemethode : REVOLVED (gedraaid)
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profiel 

profiel 
1

2 3

Er worden bij de geometriemethode ‘Ruled’ steeds 2 profielen getekend die met elkaar worden verbonden.  
De profielen kunnen achteraf worden aangepast.  

Tekenmethode : Een boog en een recht profiel. (Eenvoudig) 
Makkelijk om mee te beginnen en achteraf te bewerken.   

Teken de shell op het grondplan of in het 3D venster, bewerk de shell daarna in grondplan, doorsnede of 3D. 
1. Teken de lengte van het eerste (ronde) profiel. 
2. Bepaald de afstand tussen de 2 profielen. 
3. Teken de lengte van het tweede (rechte) profiel.

Instellingen Shell Tool  

Geometriemethode : Ruled
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Tekenmethode : loodrecht op het vlak (gedetailleerde profielen tekenen)  
Direct de profielen juist tekenen. Afstand numeriek of in 3D. 

Tip:  
Teken eerst een hulpconstructie (twee wanden) en teken dan de profielen in 3D. 

Teken de shell op het grondplan of in het 3D venster, bewerk de shell daarna in grondplan, doorsnede of 3D. 
1. Kies eerst het vlak waar het eerste profiel op ligt. 
2. Teken het eerste profiel, dubbelklik om te beëindigen. 
3. Kies het vlak waar het tweede profiel op ligt. 
4. Teken het tweede profiel. Dubbelklik om te beëindigen. 

profiel 1
profiel 2

1
2

3 4

Instellingen Shell Tool  

Geometriemethode : Ruled
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Shell Tool  

Overzicht
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Extruded                  -            Revolved                     -             Ruled 

1 Profiel , uitgetrokken over 
1 Extrusie-as 

Settings in te stellen, 
grafisch te bepalen

1 Profiel , gedraaid rond 
1 Spil-as 

Settings in te stellen, 
grafisch te bepalen 

2 Profielen  
Verbinding  

Settings niet in te stellen, 
enkel grafisch te bepalen



Shells vervormen met petpalet commando’s  

Vormen van shells kunnen voornamelijk met behulp van petpalet commando’s worden veranderd. De meeste commando’s zijn 
alleen in het 3D venster beschikbaar, sommige ook op de plattegrond. 
Voor het gebruiken van de juiste commando’s is het belangrijk op het juiste onderdeel van een shell te klikken. 
Er zijn belangrijke verschillen tussen het klikken op een rand of een hoek en tussen het klikken op een vormpolygoon (Profile 
vector) of een gewone rand of hoek.  
Op de volgende pagina’s zijn de bewerkingen voor het Shell Tool te zien en de beschikbaarheid van deze functies per shelltype en 
per klikpunt.  
 

Vervormen en aanpassen  

Petpalet commando’s - algemeen  
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Het petpalet in ARCHICAD is opgesplitst in 2 rijen. Onafhankelijk van welke commando’s in het petpalet verschijnen staan in de 
bovenste rij altijd functies waarmee onderdelen vervormd kunnen worden en in de onderste rij functies waarmee elementen zonder 
vervorming verplaatst kunnen worden.  

 

Vervormen en aanpassen  

Petpalet commando’s - overzicht  
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Vervormen en aanpassen  

Petpalet commando’s - 1  
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Vervormen en aanpassen  

Petpalet commando’s - 2 
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Vervormen en aanpassen  

Petpalet commando’s - 3 
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Vervormen en aanpassen  

Petpalet commando’s - 4 
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Vervormen en aanpassen  

Petpalet commando’s - 5  
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Vervormen en aanpassen  

Petpalet commando’s - 6  
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Vervormen en aanpassen  

Petpalet commando’s - 7  
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Vervormen en aanpassen  

Petpalet commando’s - 8  
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Vervormen en aanpassen  

Petpalet commando’s - 9  
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Vervormen en aanpassen  

Petpalet commando’s - 10  
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1

1. Teken de gewenste vorm met een fill op het grondplan. 
2. Geef de shell een grotere dikte dan de hoogte van de fill.  
3. Teken met de tekenmethode ‘detailed’ (loodrecht op het grondplan). 
4. Selecteer de shell en kies in het rechtermuismenu voor ‘Define Shell Contour’. 
5. Roep het toverstafje op (spatiebalk) en klik op de fill.  

Shell bewerken 

Contour bepalen 
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Vormen verbinden met ‘Connect’:  
• Selecteer de element(en)  
• Kies de optie Trim Elements to Roof/Shell uit de knoppenbalk, menu Design > Connect of  

context menu – Connect 
• Selecteer het element dat de operatie uitvoert. 
• Selecteer het deel van de element(en) dat moet blijven staan: het onderste of bovenste deel 
 
Ongedaan maken van een of meerdere ‘Roof/Shell Trims’: 
• Selecteer de desbetreffende elementen. 
• Ga naar Design > Connect > Clear All Connections of kies in het context menu Connect > Clear All 

Connections . 

Slechts enkele trims van meermaals getrimde elementen verwijderen:  
• Selecteer slechts één getrimd element.  

Na het trimmen wordt met een icoontje aangegeven waaraan het element getrimd is. 
• Klik op de vierkante knop naast het element. 
• Beweeg de cursor over de lijst met verbindingen, in het model worden de getrimde elementen getoond.  
• Klik op het kruisje achter de verbinding die verwijderd moet worden. 

 

Shell bewerken 

Trim en Connect (Verbinden) 
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Openingen 
Het knippen van openingen in shells werkt anders dan in andere gereedschappen. Er moet eerst via het 
context menu het commando ‘Create Hole in Shell’ gegeven worden. Daarna kan de contour getekend worden 
of met de toverstaf (spatiebalk) van een ander element worden overgenomen, bijvoorbeeld een lijn op de 
plattegrond. Met deze methode kunnen zowel op plattegronden als ook in gevels, doorsneden en in het 3D 
venster openingen aan een shell worden toegevoegd. 
Na het knippen van de opening kan de vorm van de opening met de bekende petpalet bewerkingen vervormd 
worden en in het 3D venster ook in de ruimte geroteerd worden. Hiervoor dient alleen de opening 
geselecteerd te worden. De opening is een 3D vorm die naar wens aangepast kan worden. Ook bij het 
vervormen van openingen is het belangrijk erop te letten op welk onderdeel geklikt wordt.  

Dakramen 
Daarnaast kunnen dakramen in shells worden geplaatst met de Skylight Tool.  
 

 

Shell bewerken 

Create Hole in Shell en Skylight Tool 
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1. Teken de gewenste vorm met een fill op het grondplan. 
2. Zorg ervoor dat de shell juist geroteerd staat (roteer eventueel in 3D).  
3. Selecteer de shell en kies in het contextmenu (rechter muisknop) voor ‘Create Hole in Shell’. 
4. Roep het toverstafje op (spatiebalk) en klik op de fill. 
 

 

Shell bewerken 

Een vorm aan de rand afknippen 
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1. Selecteer de fill bij de opening.  
2. De uitgeknipte vorm wordt getoond door een extrusie.  
3. Deze vorm is aanpasbaar via het petpalet. 
 

 

Shell bewerken 

Openingen bewerken
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https://www.youtube.com/watch?v=WlFajFmR_gk&list=PL646879557420F4E4&index=8

In de instellingen van de shell, tabblad ‘Model’  
Trimming body : Editable 
Het trimming body heeft nu ook een profiel-as die aangepast kan worden.  
 

 

Shell bewerken 

Trimming body aanpassen
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Gebruik de Shell Tool voor het uitrekken van bepaalde vormen. 
Het is makkelijk te tekenen en de dikte is makkelijk aan te passen! 
 

 

Shell Tool 

Toepassingen voor de Shell Tool
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Gerechtsgebouw Antwerpen - Richard Rogers 
 

 

Shell Tool 

Toepassingen voor de Shell Tool
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profiel 1

profiel 2

profiel 1

profiel 2
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05 Dakkapellen

Methode 1: Standaard objecten ‘dakkapellen’ 

Voordelen:  
• Snelle mogelijkheid om dakkapel te testen. 
• Als aankleding van omgevingsgebouwen. 

Nadelen :  
• Afhankelijk van parameters beschikbaar  

in de objecten. 
• Geen gedetailleerde aansluitingen.  

Tip: 
Dakkapellen kunnen beter gemaakt worden met het wand, dak en raamgereedschap. 
Voor de zwaluwdakkapel kan de Shell Tool gebruikt worden.

Standaard dakkapellen  

Object gereedschap of Skylight gereedschap  
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Methode 2: Samengestelde dakkapellen uit wanden en daken 

Bestaat uit: 
1   Dakvlak - composite 
1   Multi-plane Roof of 2 Single-plane Roofs als dak voor het dakkapel 
3  Wanden met een raam 

Voordelen:  
• Meer controle over aansluitingen. 
• Betere informatiestructuur over bouwdelen (wand, dak, raam) 

Nadelen :  
• Vergt meer handelingen om het te maken 
• Extra handeling voor correcte weergave van  

afgesneden wanden 

Eigen dakkapellen  

Wandgereedschap en dakgereedschap 
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Stappenplan deel 1: 

1. Teken het hoofddak.  

2. Teken de wanden van de dakkapel. 

3. Teken het dak van de dakkapel. 

4. Knip een gat in het dak tussen de wanden.  

5. Gebruik ‘Trim to Roof’ om het dak van het dakkapel  
af te snijden. 
of 
Gebruik ‘Trim’(       Ctrl-klik /      Cmd-klik) om 
dakranden aan te sluiten op een opening.

Dakkapel 

Samengesteld dakkapel modelleren
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1 2

3 5



Stappenplan deel 2: 

5. Trim de wanden met het dak van de dakkapel met 
‘Trim to Roof’. 

6. Pas de randen hiervan aan in het 2D of 3D venster via 
‘Custom Edge Settings’. 

7. Knip de wanden af aan het dak via Trim to Roof.  
Behoud het bovenste gedeelte van de wanden. 

8. In de plattegrond worden afgesneden wanden nog niet 
goed getoond. Wanden die hun referentielijn niveau 
hebben onder het snedevlak (+1500) worden geheel 
getoond.  
Stel de Floor plan Display in op ‘Outline Only’ met een 
stippellijn. Knip deze wanden eventueel op als een deel 
van de wand wel zichtbaar moet blijven. 

Dakkapel 

Samengesteld dakkapel modelleren
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5

7

Volg het stappenplan methode 2 zoals bij een Multi-plane  
Roof dakkapel.  
Teken het dak van de dakkapel met een ‘Ruled’ Shell Tool.  

Gebruik deze methode voor het tekenen van  
dakkapellen op bijvoorbeeld rieten daken. 

Dakkapel 

Rieten dakkapel
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06 Roof Maker

Voor het maken van dakconstructies is het mogelijk om gebruik  
te maken van een ingebouwde add-on ‘RoofMaker’. 

Voor het makkelijker tekenen van een dakconstructie.  
• Muurplaat / slof 
• Staander / trekker 
• Gordingen  
• Nokgording 
• Kepers 
• Klossen (slapers) 
• … 

Starten: 
Maak gebruik van de Roof Wizard: 
• Ga naar de plattegrond 
• Selecteer een dak (Single- of Multi-plane) 
• Ga naar Design > Roof Extra’s > RoofMaker > Roof Wizard.. 

Maak ook gebruik van de Toolbox door te kiezen voor  
‘Show RoofMaker Toolbox’ in Design > Roof Extra’s > RoofMaker 

Roof Maker 

Algemeen 
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Rafter 
Multiple Rafter 
Hip Valley Rafter 
Trimmer 
Purlin 
Eaves Purlin 
Collar Beam 
Tie Beam 
Roof Wizard

Kepers 
Meervoudige kepers 
Kil-keper 
Klos 
Gording 
Hoek gording 
Nok trekker 
Trekker 
Roof Wizard

Roof Maker Toolbox



Eigenschappen: 
De add-on plaatst objecten die achteraf aangepast kunnen worden via de  
Object Tool. 

Alle objecten zijn standaard te vinden in de bibliotheek (Add-on Bibliotheek 
> RoofMaker bibliotheek) 

Als deze objecten getekend worden via de RoofMaker wordt vorm en 
helling ontleend aan de vormgeving van het dak. 

Let op! 
Roofmaker objecten maken geen live verbinding. Na aanpassing 
van de dakhelling moet de constructie opnieuw geplaatst of 
aangepast worden. 

Roof Maker 

Algemeen 
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• Dakstructuur 
• Houtskeletbouw * 
• Balkenstructuur * 
• Gevelstructuur onder de afwerkingslaag * 
• Regelwerk met een speciale vorm * 
• … 

Voordelen:  
• De balklaag kan worden gecreëerd volgens een vrije vorm.  
• Het zijn aparte objecten met eigen instellingen. 
• Ze worden gegroepeerd getekend.  

Nadelen:  
• Enkel keuze uit aanwezige profielen (vierkantige / rechthoekige balken). 
• Er is altijd een hulpvlak nodig (Roof Tool). 

* De RoofMaker kan enkel gebruikt worden bij een dakvlak getekend met de Roof Tool. Dit ‘dakvlak’ kan als 
hulpvlak worden getekend en achteraf worden verwijderd of verborgen.
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Voor de aanvang:  
Let op de spilas van het dakvlak (Pivot line).  
Deze lijn wordt bij de structuur o.a. gebruikt als rotatiepunt in de objecten.  
Ook als er een onderkant van de dak-overstek wordt getekend wordt deze bepaald aan de hand van de Pivot line. 

Tip:  
Plaats de Pivot line van het dak aan de buitenkant van de dragende wand (ter plaatse van de muurplaat).  
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Plek waar de Pivot line van het dak was toen de structuur gegenereerd werd. Hier wordt 
de spilas geplaatst van het object. 
Na het aanmaken is dit punt niet meer gekoppeld aan de Pivot line van het dak.

Rafters (Kepers) : 
1. Selecteer een dakvlak (of Multi-plane roof) 
2. Kies voor Create a rafter… / Create multiple rafters… 
3. Melding bij Multi-plane roof: Klik op OK, selecteer het dakvlak waar 

de kepers in komen.  
4. Bepaal de juiste instellingen en kies de juiste laag.  
5. Teken de ‘verdeellijn’ in het dakvlak.  
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Hip of Valley rafter (Kilkepers) / Purlin (Gording) / Eaves purlin (Hoek gording): 
1. Er moet een lijn gebruikt worden voor het tekenen. Dit kan een  

snijlijn zijn van de dakvlakken (nok of kiel) of een hulplijn die getekend is met 
het lijngereedschap.  

Tip:  
Gebruik Roof level lines om de lijn op de juiste hoogte te tekenen!  

2. Selecteer een dakvlak (of Multi-plane roof). 
3. Kies voor Create a hip or valley rafter… / Create a purlin… /  

Create an eaves purlin…  
4. Melding bij Multi-plane roof: Klik op OK, selecteer het dakvlak waar de kilkeper /  

gording in komt.  
5. Bepaal de juiste instellingen en kies de juiste laag.  
6. Klik op de hulplijn / nok / snijlijn van de dakvlakken (Kilkeper). 

4
3
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Trimmer (klos) : 
1. Selecteer 2 reeds getekende kepers die parallel aan elkaar liggen! 
2. Kies voor Create a trimmer… 
3. Bepaal de juiste instellingen en kies de juiste laag.  
4. Klik op de plaats tussen de kepers waar het koppelstuk komt. 
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Collar beam (Nok trekker) / Tie beam (Trekker) : 
1. Selecteer 2 reeds getekende kepers die in elkaars verlengde liggen! 
2. Kies voor Create collar beams… / Create tie beams… 
3. Bepaal de juiste instellingen en kies de juiste laag.  
4. Klik op OK.
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Opbouw : 

1. Begin met het tekenen van de muurplaat (Create an eaves purlin…), 
2. De gordingen en de nokbalk. (Create a purlin…). 

Tip:  
Teken op voorhand hulplijnen op de juiste hoogte via Design > Roof Extra’s > Create roof level lines… 

3. Ga verder met de kilkepers (Create a hip or valley rafter…). 
4. Teken de overige kepers (Create a rafter… / Create multiple rafters…). 
5. Werk af met het tekenen van de trekkers (Create collar beams… / Create tie beams… ). 
6. Gebruik de Object Tool met de extra RoofMaker bibliotheek voor nog extra  

toevoegingen als steunen en basistrekkers.  

Tip :  
Teken een extra dakvlak waarmee de structuur gegenereerd wordt. Geef dit dakvlak een gelijke dikte als de kepers en zet het 
op de laag ‘B SEO Operators’. Dit vlak kan nu gebruikt worden om elementen af te knippen.  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Via de Roof Wizard wordt een dakstructuur in een keer gegenereerd.  
1. Selecteer een dak (Single-plane of Multi-plane roof). 
2. Ga naar Design > Roof Extra’s > RoofMaker > Roof Wizard… 
3. Bepaal de instellingen van de verschillende elementen.  

Speciale dakvormen worden makkelijk voorzien van een structuur! 
De dakelementen getekend met de Roof Wizard worden gegroepeerd. 
Let bij het bewerken daarom erop dat ‘suspend groups’ aan staat.  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De verschillende elementen kunnen achteraf aangepast 
worden door het instellingenvenster te openen.  

Ook de plattegrondweergave kan hier gewijzigd worden. 

Roof Maker 

Elementen bewerken

M+ - �87



De structuurelementen kunnen in een schedule getoond worden, 
o.a. voor het opstellen van meetstaten.  
Gebruik hiervoor de schedule ‘checklist objecten’  
als basis.  

Open de Scheme Settings en voeg bij criteria de laag van de 
structuurelementen als filteronderdeel toe. 
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